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IN THIS SECTION . . .

• Overview of Win-Situ
• Installing Win-Situ

OVERVIEW OF WIN-SITU

Win-Situ™ 2000 is easy-to-use software that connects your computer to
In-Situ’s MiniTROLL.

Win-Situ 2000 also supports communication with In-Situ’s TROLL 4000,
Multi-Parameter TROLL 8000, and HERMIT 3000 devices.

Use Win-Situ 2000 to

• Set up a direct connection between a PC and one or more devices
• Set up a modem or radio connection to one or more devices
• Convert pressure measurements to depth or level readings
• Check the device’s clock, pressure range, memory, and battery
• Set up custom data collection schedules (“tests”)
• Take immediate “manual” readings
• Extract data from a device
• View, graph, and print test data files; transfer to Microsoft® Excel®

• Calibrate the device to monitor water quality parameters (when
available)

• Upgrade device firmware (when available)

PROGRAM REQUIREMENTS

Win-Situ requires (at a minimum) a computer with a 486 processor,
running Microsoft® Windows® 95, Windows 98, or Windows NT 4.0,

1
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Service Pack 4 or higher, a serial communications port, 16 megabytes of
RAM, a hard disk, VGA compatible 640 x 480 display, and a Windows-
compatible mouse or other pointing device.

INSTALLING WIN-SITU 2000

Insert the Win-Situ 2000 CD or floppy disk in the appropriate drive of your
computer.

• CD: If the CD-ROM drive is set to Auto-Play, the installation program
will start automatically. If necessary, choose Run from the Windows
Start Menu and type D:\Setup, where D is your CD-ROM drive.

• Floppy disk: Choose Run from the Windows Start Menu and type
A:\Setup, where A designates your floppy disk drive.

Follow the instructions to install the program to your local hard drive. A
shortcut will be created on the desktop:

For more information . . .

How to See page
Start Win-Situ 3
Navigate the Win-Situ screen 8
Connect to a device 4
Set the device clock 5, 15
Take a manual reading 15
Set up a data collection test 25
Give the device a unique name 15
Check the pressure range 11-12
Check the battery & memory capacity 10
Set up to measure water levels 17
Calibrate an MP TROLL for water quality 24
Check the firmware version 10
Set unit preferences 14

SECTION 1: INTRODUCTION
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2
GETTING STARTED

IN THIS SECTION . . .

• Connecting For the First Time
• Your Next Win-Situ Session
• About Sites and Connections

CONNECTING FOR THE FIRST TIME

STEP 1: CONNECT THE DATA LOGGER TO THE PC

Refer to the Operator’s Manual for your data logger for specific
information on connecting the device to your computer’s serial port and
supplying it with external power, if desired.

STEP 2: START WIN-SITU

Start Win-Situ with one of these methods:

• double-click the Win-Situ 2000 shortcut on the desktop

• use the Start Menu to select it from the item “In-Situ Inc.”

Note that you cannot run Win-Situ from the CD or floppy disk; the
program must be installed to your local hard drive (see page 2).

CAUTION: In-Situ’s MiniTROLL communicates via RS485
protocols. An RS485/RS232 converter is necessary to talk to
a MiniTROLL.
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SECTION 2: GETTING STARTED

The Win-Situ application window appears. A new, empty site called
“Home” is displayed at the top of the Navigation tree on the left side of
the screen.

STEP 3: ADD A CONNECTION TO THE “HOME” SITE

A connection is simply a COM port on your computer. The Connection
Wizard asks a few questions to help you specify the properties of this
connection, including—

• Connection Type: To connect to an In-Situ data logging device
attached to the COM port, select “direct” connection. For other
types, see “About the Connection Wizard” on page 7.

• Connection Strategy: One device or more than one.

• Communications Port: The COM port (RS232 serial port) to
which the device is attached.

• Connection Speed: Baud rate for communications.

• Name (optional): A default connection name is suggested.

• To have the wizard connect automatically to the attached device,
be sure the option Connect and find devices on “Finish” is
checked.

STEP 4: CONNECT

1. If you
requested
Win-Situ to
connect and
find devices,
proceed to
step 3.

2. To connect
manually, click
the Connect
button.

3. The following
will happen:

• Win-Situ synchronizes the baud rate of the device to the host
computer.

TIP: The first time you launch Win-Situ, the Connection
Wizard starts automatically to help you add a connection.

To  connect manually,
click here
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• Win-Situ “finds” (connects to) the device(s). For a modem
connection, Win-Situ initiates a phone call.

• The status bar at the bottom of the screen shows the state of
communications between Win-Situ and the device.

• After the connection is made, the device appears in the Naviga-
tion tree.

4. Click to select the device in the Navigation tree. If more than one
device was located, select the one you want to talk to first.

STEP 5: SET THE CLOCK

The device clock is shown in the right corner of the status bar. Data
collection schedules depend on the device clock. Set it as follows:

1. With the device selected in the Navigation tree, click Set Device
Clock.

2. Select one of these options:

• If the device clock is wrong but the PC clock is right, select
Syncronize Device Clock to Computer Clock.

• To use a different time for the device, select the second option
and enter the desired device time.

3. Click Finish. The new time will be sent to the device.

If the device does not appear in the tree, there may be a
communication problem between Win-Situ and the device.
Check these items: (1) the COM port, (2) the hardware
connections, (3) the device’s battery or external power.

SECTION 2: GETTING STARTED

Device clock
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SECTION 2: GETTING STARTED

EXITING WIN-SITU

1. Select Exit from the File menu.

2. If changes have been made to the site, Win-Situ will ask if you want
to save the modifications. Such modifications may include the initial
configuration of an empty site, as well as unit preferences saved in
the site file. Do one of the following:

• Select Yes to save the current settings for future use. This site
will open the next time you launch Win-Situ.

• Select No to abandon the changes. In this case, the “Home” site
will again open up blank when you start Win-Situ the next time.

For more information, see “About Sites and Connections” below.

YOUR NEXT WIN-SITU SESSION

Each time you start Win-Situ, the site and the connection (if any) saved
in your last session are displayed in the navigation tree.

To connect:

1. Select the connec-
tion.

2. Click the Connect
button.

ABOUT SITES AND CONNECTIONS

The site is the topmost node in Win-Situ’s Navigation tree. A site
consists of one or more connections.

When you launch Win-Situ for the first time, a new, empty site called
“Home” is opened and displayed at the top of the Navigation tree. You
can add one or more connections to the site with the Add Connection
button.

When learning to use the software in the office, with a direct connection
to a device such as a TROLL or MiniTROLL, think of the site as your
computer, and the connection as the COM port to which the device is
physically connected. As you develop networks of instruments and

TIP: To start Win-Situ from Windows Explorer, double-click a
Win-Situ file in the folder where Win-Situ is installed. Win-
Situ files have a .WS extension.

1

2
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access them with different computers from different locations, you may
find it useful to create and save a new site for each situation.

For example, your “Home” site could contain the port connections you
normally use on your office computer. It might include one modem
connection at 1200 baud for communicating with remote devices, and a
direct connection at higher speed for talking directly to a device at your
desk.

A field site could be configured for the COM port on your laptop. In
addition, you may discover that long cable lengths require a lower baud
rate for reliability at this site. After setting up two connections, you
could save the site under a unique identifying name, then open it
whenever you visit that site.

When setting up sites for later use, you may want to clear the checkbox
Connect and find devices on “Finish” at the end of the Connection
Wizard so the wizard does not automatically try to find attached
devices.

SAVING ADDITIONAL SITE FILES

The Save As option on the File Menu can be used to save current
connection information under a new filename. Similarly, you can set up
a new site anytime by selecting New from the File Menu.

ABOUT THE CONNECTION WIZARD

The Connection Wizard will help you set up new connections. To add a
connection to a site, select the site and click the Add Connection
button. The Connection Wizard asks for the following:

The Connection Type controls many aspects of communication
through the port. Available types are

• Direct Connection, for use when the device is attached
directly to the PC

• Modem for a dial-up modem
• Spread-Spectrum Radio

Number of devices connected: Select “one” to speed up connection
to a single device.

Communications Port: Select the appropriate RS232 serial port on
the computer. For a Modem connection, enter the phone number—up
to 40 characters; a comma designates a pause.

Connection Speed: New In-Situ data loggers are factory-set to 9600
baud, but you may select any rate; baud rates are automatically
synchronized between devices and the host computer.

SECTION 2: GETTING STARTED
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3
THE WIN-SITU
ENVIRONMENT

IN THIS SECTION . . .

• The Win-Situ Workspace
• Navigation Tree Nodes
• Win-Situ Menus

THE WIN-SITU WORKSPACE

Win-SItu uses the familiar “navigation tree” to display your network on
the left side of the screen. The pane on the right automatically displays
information about the “node” selected in the tree. The information pane
also contains buttons for actions you can perform.

Navigation Tree

Action Buttons

Information Pane
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NAVIGATION TREE NODES

Sites, connections, devices, parameters, and tests are all “nodes” in the
Navigation tree. The symbol + means a node can be expanded to show
more nodes below it.

When a node is selected in the tree,

• the Information
pane displays
information
about the
selected node.

• the Information pane displays “action buttons” for the actions that
can be performed on the selected node.

SITE NODE

When a site is selected,
the Information pane
shows the connection(s)
in the site and their
status.

Site Actions

To add a connection,
click the Add
Connection button.

To delete one or more connections, select the connection in the
Information pane and click Delete Connection(s).

CONNECTION NODE

When a connection is
selected, the Information
pane shows the
connection type, COM
port, baud rate,
connection strategy, and
phone number for a
modem connection.

TIP:  Some action buttons are available only after making a
selection within the Information pane.

SECTION 3: THE WIN-SITU ENVIRONMENT

Site
Connection

Device
Parameters

Tests

Node

Actions

Information

Node

Actions

Information
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Connection Actions

Edit Connection starts the Connection Wizard to help you change the
properties of a connection.

Connect opens the connection and locates devices. After the
connection is made, this button changes to let you Disconnect from
the device.

You can Delete or Edit a connection by choosing the appropriate
action button.

Find Devices is a shortcut to get Win-Situ to display new devices in
the tree without having to disconnect and re-connect.

DEVICE NODE

With a device selected, the Information pane shows device details: the
date it was manufactured and calibrated, its hardware and firmware
versions, storage capacity (memory), battery status (based on measured
voltage), the device clock, and more. The example below is for a
MiniTROLL.

Device Actions

Edit Device Info—Depending on the device type, you can set a custom
name and change other settings. For more info see page 15.

Set Device Clock—For details, see page 15.

Refresh Device Info—to update the display.

SECTION 3: THE WIN-SITU ENVIRONMENT

Node

Actions

Information

Device clock
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Upgrade Firmware—Available if Win-Situ can upgrade the device to a
newer firmware version. For more information, see page 16.

Device Errors—If device failures (e.g., power, memory, clock) have
occurred, this button will be available to supply details.

PARAMETERS NODE (GROUP VIEW)

To view a list of all parameters the device can measure, select the
Parameters node in the Navigation tree.

To access the action buttons:

1. Select a parameter in the Information pane. Select one or more by
holding the CTRL key while clicking.

2. Select the action button.

For the external channels of a HERMIT 3000, additional action buttons are
available.

SECTION 3: THE WIN-SITU ENVIRONMENT

TIP: With any node selected, clicking the right mouse button
displays a short, context-sensitive menu listing the same
actions available on the action buttons.

TIP: Some action buttons are unavailable when a test is
running.

2

1
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SECTION 3: THE WIN-SITU ENVIRONMENT

Advantages of the Tests node (group view): (1) Group
actions can be performed on multiple tests, and (2) New tests
can be added to the device. Refer to Sections 8 and 9 for
complete information on tests.

SINGLE PARAMETER NODES

To view more detail for an individual parameter—including the pressure
sensor range—and access more actions, view the single parameter
display:

1. Expand the Parameters node by clicking the + symbol

2. Select the parameter of interest.

Parameter Actions

Edit Parameter—Pressure readings can be customized with this button.
Refer to Section 5 for complete information. Note: This button is Edit
Channel for a HERMIT 3000.

Take Reading—displays an instant reading.

Calibrate—for the water quality parameters of a Multi-Parameter TROLL
8000.

TESTS NODE (GROUP VIEW)

To view a summary of all the tests in the device, select the Tests node in
the Navigation tree. Refer to Sections 8 and 9 for more information on
tests.

1

2
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opens a new, empty site

starts Data Manager, Win-Situ’s companion
application for displaying and graphing test data files

cancels the current locate or retrieve operation

saves the current site information

opens a previously saved site

SECTION 3: THE WIN-SITU ENVIRONMENT

SINGLE TEST NODES

To view the details of an individual test, expand the Tests node by clicking
the + symbol, then select the test of interest. Refer to Sections 8 and 9
for more information on tests.

WIN-SITU MENUS

The File Menu

Use this menu to exit Win-Situ. It also has options to create a new site,
open a previously saved site, save current connection information in a
new file, which can be useful in some situations. See “About Sites and
Connections” on page 6 for details.

The Options Menu

Allows you to set preferences, including units for displaying data.

The Help     Menu

Accesses an electronic version of this operator’s manual.

THE TOOLBAR

The toolbar buttons provide quick access to Win-Situ’s most useful
operations:
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4
SPECIAL ACTIONS

IN THIS SECTION . . .

• Choosing Measurement Units
• Setting the Device Clock
• Taking “Manual” Readings
• Setting a Device Name
• Configuring TROLLs, MP TROLLs, and HERMITs for

Telemetry/Network Communications
• Reloading Firmware

CHOOSING MEASUREMENT UNITS

Default units are used until you specify a choice of units. You can
always change the units later, when displaying data in Data Manager.
Unit preferences can be set at any time using the Options menu, and
are saved in the Site file.

1. Select Preferences from the Options menu.

2. In the Modify Unit Display Preferences window, click to select the
parameter whose unit you wish to change.

3. In the bottom half of the window, select the unit you want for the
highlighted measurement.

4. Repeat for another measurement and unit, or click OK.

TIP: Unit Display Preferences affect only the display of data,
not the data collected. To preserve unit selections for future
sessions, be sure to save the site when exiting Win-Situ.
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SECTION 4: SPECIAL ACTIONS

SETTING THE DEVICE CLOCK

Data collection schedules depend on the device’s real-time clock. The
clock is always displayed in the lower right corner of the screen in the
Device Information pane. If the clock is wrong, set it as follows:

1. Select the device in the Navigation tree.

2. Select the action button Set Device Clock.

3. Select one of these options:

• If the device clock is wrong but the PC clock is right, select
Syncronize Device Clock to Computer Clock.

• To use a different time for the device, select the second option
and enter the desired device time.

4. Click Finish. The new time will be sent to the device.

TAKING “MANUAL” READINGS

Devices collect data in “tests” but you can get a quick “manual” reading
from any device apart from a test, even while a test is running. This can
aid in positioning a pressure probe in a well, and also confirm that the
device is operating properly.

1. Navigate to the device’s Parameters node.

2. In the Information pane, select a parameter.

3. Click Take Reading. A current reading will be displayed.

• Readings will be in default units until you specify your unit
preferences using the Options menu.

• External probes with long warmup times will take longer to read.

• If a test is running and the device is about to take a test reading,
the request may have to be sent several times.

SETTING A DEVICE NAME

Win-Situ recognizes a device by its serial number. In addition, you can
assign a meaningful description—such as a well or site name, location
coordinates, etc.—to be displayed in the navigation tree and data files.

1. Select the device in the Navigation tree.

2. Select the action button Edit Device Info.

3. Enter a new name for the device (up to 16 characters)

TIP: In Level display mode, two readings may be shown. For
additional information, see page 20.
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SECTION 4: SPECIAL ACTIONS

4. Click Finish. Win-Situ will send the new name to the device and
display it in the navigation tree.

CONFIGURING TROLLS, MP TROLLS, AND
HERMITS FOR TELEMETRY/NETWORK
COMMUNICATIONS

When planning to use a TROLL 4000, Multi-Parameter TROLL 8000, or
HERMIT 3000 with a telemetry connection or RS422 network, connect
directly to each logger and specify communication settings before final
field installation.

1. Select the device in the Navigation tree.

2. Click the Edit Device Info button in the Information pane.

3. Select a Primary Connection Type for the device—how you intend to
communicate with the device in its final setup. Select from

• Direct
• Modem
• Spread Spectrum Radio

4. Specify whether the device will be used in an RS422 network

5. Select Pre- and post-transmission delays (or accept the defaults).

Win-Situ will set the required communication parameters in the device
based on your selection. These settings insure that communications
will not be lost should a reset condition occur.

UPGRADING FIRMWARE

The MiniTROLL is available in Standard, Advanced, and Professional
versions, each offering a different feature set. The Standard and
Advanced models may be field-upgraded by keying in an upgrade
code, issued by In-Situ when an upgrade is purchased for a specific
MiniTROLL serial number. In addition, In-Situ may distribute new
firmware for data logging devices in the form of a file you can copy to
the folder where Win-Situ is installed. If you have a Standard or
Advanced MiniTROLL, or if Win-Situ detects a later version of firmware
than that currently loaded in the device, the Upgrade Firmware action
will be available in the Device Information pane.

1. Select the device in the Navigation tree.

2. Click the Upgrade Firmware button in the Information pane. If this
button is not available, then Win-Situ cannot upgrade firmware.

3. Follow the instructions in the Upgrade Wizard.
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5
PRESSURE
PARAMETER SETUP

IN THIS SECTION . . .

• About the Pressure Parameter
• Editing the Pressure Parameter

ABOUT THE PRESSURE PARAMETER

In-Situ’s MiniTROLL and TROLL 4000 measure two parameters:
pressure (water level) and temperature. The Multi-Parameter TROLL
8000 and PXD pressure transducers also measure pressure. Options in
the Parameter Wizard let you tell Win-Situ exactly how you want to
display pressure measurements—as raw pressure head above the
sensor, as depth, or as water level with a reference.

EDITING THE PRESSURE PARAMETER

The Parameter wizard can help you configure a pressure channel to
display measurements just as you want them. The specified settings
are easily changed from one mode to another, and any choice can be
redone or undone later, when viewing test data.

1. In the navigation tree, select a pressure parameter.

2. In the Information pane, select the action button Edit Parameter
(Edit Channel for an external pressure transducer).

If the device is running a test, the Edit Parameter function will
not be available.
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SECTION 5: PRESSURE PARAMETER SETUP

The Parameter Wizard will help you enter the required information.
The choices are discussed below.

3. Click Finish to complete the Wizard. Win-Situ will send the
information to the device and update the display.

Name

A default name is supplied for display in the Navigation tree and test
data files. If you choose, you can enter a custom name.

Display Mode

Select one of the following. Subsequent screens will be tailored to your
choice.

• Pressure Head displays the raw
pressure exerted by the column of
water above the pressure sensor, in
kiloPascals, pounds per square inch,
bars, or kilograms per square
centimeter. If you choose this mode,
click Finish to end the Wizard.

• Depth converts the pressure of the
water column to a depth reading, in
meters, centimeters, feet, or inches.

TIP: To change the units for pressure, depth, or level
readings, select Preferences from the Options Menu.

1

2

Depth
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SECTION 5: PRESSURE PARAMETER SETUP

• Level - Surface: Commonly used for
surface water elevations. Data file
readings are “positive up.” Increasing
water levels will result in increasing
readings. Decreasing water levels
correspond to decreasing readings.

• Level - Top Of Casing:  Commonly
used for drawdown in groundwater
wells. This mode is “positive down.”
Decreasing water levels correspond to
increasing readings, because the water
level is getting further from the top of
the well casing. Increasing water levels
result in decreasing readings.

Level/Depth Conversion Information

The conversion from pressure in pounds per square inch (psi) to depth
or level in meters or feet requires several conversion factors. Pressure
in the English unit psi is converted to the SI unit Pascal (Pa).
Conversion from Pascals to meters or feet requires two additional
values:

• Liquid Density. Pure groundwater at 20°C has a density of 0.998 g/
cm3. Refer to the Appendix for a temperature/density table and a
method for experimentally determining liquid density if the working
fluid is not pure water.

• Gravitational Acceleration. The acceleration due to gravity that an
object experiences is location-specific. Given your latitude and
elevation, Win-Situ can calculate a value for gravitational accelera-
tion.

Earlier versions of Win-Situ before Win-Situ 2000 used a dimensionless
specific gravity value to convert from pressure to feet or meters of fluid.
A specific gravity of 1.0 is adequate for many groundwater applications.

TIP: Either specific gravity or density, latitude & elevation
may be used to convert from pressure (psi) to depth/level
(meters or feet ). A gain in accuracy may be realized by
selecting the density, latitude & elevation option.
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SECTION 5: PRESSURE PARAMETER SETUP

Level Reference

User-specified starting point for level display modes. Here are some
examples:

• Surface: Calculate the water level above mean sea level (MSL) and
enter as the Level Reference. Data will be displayed as elevations
above MSL.

• TOC: Measure the distance to the water surface from the top of the
well casing (DTW) and enter as the Level Reference. Data will be
displayed as DTW values.

• A Level Reference of 0 is equivalent to “zeroing” the probe. Data will
be displayed as changes from the starting water level.

A current reading of the sensor depth is displayed in this screen; you
can reposition the probe and update the reading with the Update
Reading button.

Reference Time

The device takes a “snapshot” of the sensor’s raw pressure reading,
then your Level Reference is substituted. You can specify that the
snapshot be taken now or when the test starts. The data file will show
the Reference (raw pressure) Reading and when it was taken.

• Now: the pressure is measured immediately and the value is stored
until the test starts. All measurements taken during the test will be
relative to the water level at the time you finished the wizard.

• Start of Test: the Reference measurement will be taken at time t=0.
All measurements taken during the test will be relative to the water
level at the moment the test starts.

TIP: To display “manual” readings that take your Level
Reference into account, select Reference Time: Now.
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6
HERMIT 3000
CHANNEL SETUP

IN THIS SECTION . . .

• About External Channels
• Editing External Channels

ABOUT EXTERNAL CHANNELS

The HERMIT 3000 data logger can
accommodate up to eight 4-20 milliAmp
probes, such as pressure transducers,
attached to its eight numbered channel
connectors. To interpret the output of each
channel, Win-Situ requires specific information on the type of
probe connected and its calibration coefficients. If your software
supports the HERMIT 3000, you can supply this information by
“editing” each channel individually.

EDITING EXTERNAL CHANNELS

Use the following procedure to set up an external channel:

1. In the navigation tree for a HERMIT 3000, select a channel to which
you have attached (or plan to attach) a 4-20 mA probe.

2. In the Information pane, select the action button Edit Channel.

If the HERMIT is running a test, the Edit Channel function will
not be available.
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The Channel Wizard will help you enter the required information.
The choices are discussed below.

3. Click Finish to complete the Wizard. Win-Situ will send the
information to the device and update the display.

Type

Select the type of probe attached to this channel. Subsequent screens
will be tailored to your choice. All but two of the types are self-
explanatory:

• Select Undefined to clear a probe definition when removing a
previously-attached probe. All channels start as Undefined types.

• Select User-Defined for a third-party probe, or if your type isn’t
listed. For In-Situ probes, the Linearity, Scale, and Offset coeffi-
cients determine the units for the readings, and conversions from
one unit to another are easily done. The User-Defined type returns
readings in the probe’s “native unit,” and conversions to other units
are not possible. You’ll also be asked to enter a Warmup time, in
milliseconds. This is the time required to power the channel and
return an accurate reading. You may have to determine this value
by experiment. Maximum: 30,000 ms (30 seconds).

SECTION 6: HERMIT 3000 CHANNEL SETUP

TIP: The HERMIT’s internal barometric channel is always
channel 0 and cannot be edited.

1

2
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Calibration Coefficients

Enter the Linearity, Scale, and Offset.

• In-Situ pressure transducers display this information on the probe’s
data tag, and in accompanying calibration documents.

• For a User-Defined type, enter the range as the Scale, and zero for
Linearity and Offset (unless you know them).

• If a coefficient is negative (e.g., Offset), be sure to enter a minus
sign.

Name

A default name is supplied, but you can enter a more descriptive name
to appear in the navigation tree and in the test data files—for example,
the probe’s model or serial number.

This completes the channel setup.

CHANNEL DEFINITIONS: BACKGROUND

The data logger stores one definition for each channel and uses it in
any tests that include the channel. If you edit channel settings before a
test runs, the new definition will be used in the test. If you edit a
channel after a test has run, no changes will be made to the channel
definition used in the test.

The data logger stores data in a binary format independent of your
channel settings. After collecting and extracting data, you can choose
to display data (and optionally create text files) using these settings, or
you can change any of these settings at that time. Making changes
later affects only the displayed data or created text files, but it will not
change your original binary data file, unless you want it to. The result is
a high degree of flexibility with no danger of changing—and thus
possibly compromising—the original data.

SECTION 6: HERMIT 3000 CHANNEL SETUP

TIP: When editing a pressure channel, the wizard presents
additional options. Refer to Section 5 for details.



24

0024690 rev. 002  09/00

IN THIS SECTION . . .

• About Water Quality Parameters

ABOUT WATER-QUALITY PARAMETERS

In-Situ’s Multi-Parameter TROLL 8000 can measure three water-quality
parameters in addition to pressure and temperature. The MP TROLL is
available in two versions

• pressure, temperature, pH, dissolved oxygen (DO), and conductivity

• pressure, temperature, pH, DO, and oxidation-reduction potential
(ORP)

If your software supports the MP TROLL, the Calibrate button is
available when a water-quality parameter is selected in the Navigation
tree. The calibration wizard will help you through the calibration
process.

7
WATER-QUALITY
PARAMETER
SETUP

Complete procedures for calibrating the Multi-Parameter TROLL
8000 for pH, conductivity, DO, and ORP are found in the MP
TROLL 8000 Operator’s Manual.
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8
TEST SETUP

IN THIS SECTION . . .

• About Tests
• Adding a Test to a Device: The Test Wizard

ABOUT TESTS

Collecting a set of data is called “running a test.” Many things that you
do through Win-Situ can be visualized as actions performed on Tests.
For example,

• to give the device instructions for collecting data you add a test to
the device.

• when you want the device to end data collection you stop a test.
• to copy test data from the device to a host computer you extract

test data.

These actions are initiated by buttons in the Information pane when the
device’s Tests node (group view) or a Single test is selected in the
Navigation tree.

ADDING A TEST TO A DEVICE: THE TEST
WIZARD

1. Navigate to the device’s Tests node.

Advantages of the Tests node (group view):  (1) the Add
Test action is available, and (2)  operations can be performed
on multiple tests simultaneously.
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SECTION 8: TEST SETUP

2. Select the action Add Test to Device. The Test Wizard will help
you enter the information. The choices are discussed below.

3. Click Finish to complete the Test Wizard. Win-Situ will write the
information to the device and display the new test properties in the
Information pane.

Name (optional)

Enter up to 16 characters to uniquely identify the test in the Navigation
tree and in the test data file.

Parameters

Select the parameters you want to measure. Remaining choices will be
tailored to your selection. For example, a log test is not available when
water-quality parameters are being measured with an MP TROLL 8000.

Test Type

Test types available depend on your device’s firmware.

Linear. Measurements are evenly spaced and all measurements are
stored.

Event. Measurements are evenly spaced, but you can record an
“event” and conserve memory by having the device store only
measurements that differ from the previous measurement by an
amount you specify.

Log. Measurements are closely spaced at the start of the test and get
further apart as the test progresses. All measurements are stored. The
appendix describes the log schedule in more detail.

1

2
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SECTION 8: TEST SETUP

Mini TROLL TROLL HERMIT
Parameter TROLL 4000 8000 3000

Pressure 0.5 sec 3 sec 3 sec 10 sec
Water level 0.5 sec 3 sec 3 sec 10 sec
Temperature 0.5 sec 3 sec 3 sec 10 sec
pH -- -- 15 sec 15 sec
Conductivity -- -- 15 sec --
ORP -- -- 15 sec --
Dissolved oxygen -- -- 5 min --

Minimum Linear Measurement Intervals

TIP: In entering the Scheduled Start time, keep in mind that
when this test starts, it will automatically stop a currently
running test.

TIP: The end of a test cannot be programmed in advance.  In
most cases, the Stop button is the only way to end a test.
Exceptions: A test stops automatically (1) when another test
starts, and (2) when the device memory is full.

Linear Average. Available for TROLL and MiniTROLL level and
temperature measurements, this type of test can smooth out
anomalous highs and lows (e.g., from waves). Each stored measure-
ment is the average of several rapid measurements.

Measurement Interval

The available interval depends on your choice of test type and parameters.

Start Option

Manual. The test can be started at any time by pressing the Start
button—for example, to  synchronize with an external event like
starting a pump.

Scheduled. The test starts at the date and time you specify. The
time shown is 10 minutes ahead of the current device time. Use the
arrows beside the list boxes to choose a start time and date.

This completes the test setup.
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9
TEST
OPERATIONS

IN THIS SECTION

• About Test Operations
• Starting a Test
• Stopping a Test
• Extracting and Viewing Data
• Deleting Tests

ABOUT TEST OPERATIONS

Test operations are initiated by action buttons in two places:

• the device’s Tests node, where information about all tests is
displayed and actions may be performed on multiple tests

• a single Test node, where actions are available for the selected test

The action buttons available depend on your test selection.

STARTING A MANUAL START TEST

1. Navigate to the device’s Tests node.

2. In the Information pane, select a pending manual test.

3. Select the action Start Test.

4. Click Yes to confirm your selection.

Once a test starts, the following actions will not be available:
Add Test, Delete Test(s), Edit Test, Set Device Clock, Edit
Device Info, Edit Parameter.
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SECTION 9: TEST OPERATIONS

5. Win-Situ will start the test.

If a test is running, Win-Situ will stop the running test and then start
the selected test. Depending on how busy the device is, this can
happen virtually simultaneously.

STOPPING A TEST

The end of a test cannot be programmed in advance. In most cases,
the Stop button is the only way to stop a running test. Exceptions: A
test stops automatically when:

• another test starts
• the device’s memory is full.

1. Navigate to the device’s Tests node.

2. Click the Stop Running Test button. Since only one test can be
running, you do not need to select a specific test.

3. Click Yes to confirm your selection.

4. Win-Situ will stop the test and update the display.

EXTRACTING & VIEWING DATA

This operation retrieves test data and saves it to a file on the host com-
puter. You can view the file immediately after the download, or later.

1. Navigate to the device’s Tests node.

2. In the Information pane, select one or more tests to extract. To
select multiple tests, hold the CTRL key while clicking.

3. Click the Extract Test Data button. Win-Situ extracts the test(s).

When the extraction is complete, Win-Situ displays the name(s) and
locations of the test data file(s) on the host computer, and presents
options:

• View  launches Data Manager to view the selected file

• Done returns to Win-Situ

TIP: You can extract and view data almost immediately after
a Linear test starts, and about 10 seconds after a Log test
starts.

For complete information on working with test files in Data
Manager, see Section 10.
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DELETING TESTS

Tests are stored in the device memory until you delete them. This
operation permanently removes selected tests from the device, and
reorganizes the memory to optimize future data storage. Depending on
how full the memory is, the process can take several minutes.

1. Navigate to the device’s Tests node.

2. In the Information pane, select one or more tests to delete.

3. Press the Delete Tests button.

4. Click Yes to confirm your selection.

5. Win-Situ will delete the selected test(s) permanently from the
device.

CAUTION: Be sure to extract data you want to save before
deleting from the device. Once a test is deleted, the data
cannot be retrieved!

TIP: The Delete procedure can be used to cancel a
pending scheduled test.

Win-Situ \ Data \ SN00120  2000-01-18  083000  drawdown.bin

Device serial number

Test start date (yyyy-mm-dd)

Test start time (hhmmss)

Test name

TIP: Win-Situ saves each test to a folder named “Data” in
the folder where Win-Situ is installed. The file structure
looks like this:

File type

TIP: “Extracting”  puts a copy of a test data file on your
computer, but does not delete the data from the device. To
free up device memory, see Deleting Tests.
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10
TEST DATA FILES

IN THIS SECTION . . .

• Overview of Data Manager
• Changing the Data Display
• Graphing Data
• Saving Text Files
• Exporting Data

OVERVIEW OF DATA MANAGER

Two areas of Win-Situ are concerned with test data files:

• The Extract Test Data button retrieves a test from the device
and saves it to a file on the host computer.

• Data Manager starts automatically when you View the extracted
data. It can also be run as a separate program for use with
previously extracted files.

Data Manager can display any test data file as a report or a graph. It
also has options that give you flexibility in displaying data.

STARTING DATA MANAGER AUTOMATICALLY

Win-Situ launches Data Manager automatically when you Extract a
test and select the View option at the end of the download. Instructions
for doing this are in Section 9, under “Extracting & Viewing Data.”

STARTING DATA MANAGER AS A STAND-ALONE APPLICATION

1. Start Data Manager using one of the following methods:
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SECTION 10: TEST DATA FILES

• In Win-Situ, select the Data button on the button bar.
• Use the Windows Start menu to select it from the group In-Situ Inc.

2. Choose Open from the Data Manager File Menu.

3. In the “Open” dialog box, select a .BIN file of test data that has been
extracted from a device.

4. Click OK. The file will open in the Data Manager window.

Data Manager, like other Windows applications, allows you to have
multiple files open and switch between them. Use options on the
Window menu to arrange the individual file windows.

CHANGING THE DATA DISPLAY

TO CHANGE MEASUREMENT UNITS

1. Select Units on the Settings menu, or click  on the toolbar

2. In the Unit Selection dialog box, highlight a measurement type in the
list on the left.

3. In the list on the right, select the unit you prefer for the measure-
ment.

4. Repeat for another measurement and unit, or click OK.

TO CHANGE HERMIT 3000 CHANNEL SETTINGS

1. Select Channel on the Settings menu, or click   .

2. The Channel Settings dialog box displays the first test channel (or
the Event channel for an Event test).

3. Use the arrow at the end of the Channel list box to display the test
channels and select the one you want to change.

4. Enter the correct type and/or coefficient(s), and click OK.

The Channel Defaults button restores the original settings.

Data Manager is designed for use with .BIN files—the format
used to extract data from a device. To avoid an error message
when opening a file in Data Manager, always select a .BIN file.

CAUTION: If the Channel Settings were entered correctly
during channel setup, do not change them.
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SECTION 10: TEST DATA FILES

TO CHANGE PRESSURE/LEVEL SETTINGS

The data file is initially displayed using the settings specified when
setting up the pressure channel. Refer to Section 5 for details on the
settings.

1. Select Pressure from the Settings Menu, or click    .

2. In the Pressure/Level Settings dialog box, change any or all of the
settings:

• Reading Type: pressure head, depth, or level
• Pressure to depth/level conversion using specific gravity

or using density, latitude & elevation
• Barometric compensation for HERMIT 3000 channels
• Level reference
• Time at which the reference reading is/was taken

3. Click OK to accept the changes and return to the data display. (The
Channel Defaults button restores the original settings.)

GRAPHING DATA

Select the Graph option on the View Menu to view the data file in

graph format or click     .

A check here means
the reference
reading will be set to
the pressure head of
the first measure-
ment. If you
originally chose to
take the reference
reading “at start of
test,” this option is
not available.
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SECTION 10: TEST DATA FILES

As with the Report format, the initial display reflects the choices you
made when you defined the channels (or your most recent selections in
the Pressure/Level Settings dialog box).

TO CHANGE GRAPH SETTINGS

1. To customize the look and content of a graph, select Graph from

the Settings Menu, or click     on the toolbar.

2. In the Graph Settings dialog box make your selections in each
group of settings:

General Settings

Graph Title: The default title suggested is the test name.

Lines/Symbols: The graph can show symbols for data points, lines
connecting the data points, or both (symbols connected by lines).

Color: When this box is checked, the lines/symbols are displayed in
color. When printing to a black-and-white printer, the symbols will be
sharper if this box is cleared.

Symbol per every: The default is one symbol for each data point in the
file. You can plot every other data point by entering “2” here, or
every third by entering “3,” and so on.

Adding and Removing Channels

Use the Select Channels button in the Graph Settings dialog box to
remove channels from the graph. For example, if a test recorded water
level and temperature, you may want to plot just water level. Or if your

Graph view

Y-Axis
(pressure)

Y-Axis
(temperature)

X-Axis (time)



35

0024690 rev. 002  09/00

SECTION 10: TEST DATA FILES

test used more than the maximum of 2 types, the two chosen for the
plot will be the first two in the test (i.e., the lowest channel numbers).
You can use this procedure to plot channels other than the defaults.

1. In the Graph Settings dialog box, click Select Channels.

2. In the Channel Selection dialog box, the plotted channels are shown
in the Selected Channels list. Channels in the Available Channels
list will not be plotted.

• To remove a channel: highlight the channel in the Selected
Channels list, then click < Remove.

• To add a channel: highlight the channel in the Available Chan-
nels list, then click Add >.

3. Click OK through two dialog boxes. The graph will reappear with
your selected channels plotted.

SCALING THE AXES

“Scale” refers to the range or extent of an axis, determined by its
minimum value (starting point) and maximum value (ending point).
Scaling can “zoom in” on an area of the data.

When a graph is first displayed, both axes are automatically scaled to
include all the data in the file. This is “auto-scaling.” Anytime you
change the Pressure/Level Settings, the Y-axis will be auto-scaled.

Auto-scaling produces an acceptable plot, but if you wish, you can
customize it by scaling one or both axes, as described below.

X-Axis Scaling

Log Scale: Check this box to get a logarithmic X-axis. Time units will be
set to minutes if you select this option.

Gridlines: Check this box for gridlines on the axis.

Selected: The minimum (MinX) and maximum (MaxX) time values
plotted. To change the scale of the axis, enter the minimum and
maximum values you want to plot.

Data Span: The minimum (MinX) and maximum (MaxX) time values in
the data file. Shown for your information only.

Auto Scale X: Rescales the X-axis to include all the data in the file.

TIP: A graph can show 2 measurement types (e.g., level and
temperature), and up to 6 channels.
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Y-Axis Scaling

Two measurement types can be shown. This means the graph can have
two Y-axes. The scale for one is shown on the left, the other on the right.
A pressure/level axis will always be on the left.

When two measurement types are plotted, each Y-axis is scaled
independently. The current type is shown in the Measurement box, and
its unit appears after the words “Y-Axis Scaling.” To select a different
type (if available), click the arrow at the end of the Measurement box to
display the available types. Click the one for the axis you want to scale.

Inv. Scale: Check this box to invert the axis.

Log Scale: Check here for a logarithmic Y-axis (except temperature).

Gridlines: Check this box for gridlines on the axis.

Selected: The minimum (MinY) and maximum (MaxY) values plotted for
this axis. When the range in the data file is small, the proposed
scale is considerably wider than the data span. This range is
chosen automatically by Data Manager. To change it, enter different
MinY and MaxY values.

Data Span: The minimum (MinY) and maximum (MaxY) values in the
data file for this axis. Shown for your information only.

Auto Scale Y: Rescales the Y-axis to its original settings.

SAVING TEXT FILES

1. Click    for Report view.

2. Select Save As from the File Menu.

3. In the Save File as Type box, select Text files (.TXT).

4. Supply a file name in the usual way and click OK.  The original binary
file remains unchanged. The new text file contains the data as
currently displayed.

TRANSFERRING DATA TO EXCEL

If Microsoft Excel is properly installed on your computer, you can easily
export a data file (report view) to an Excel spreadsheet.

1. Click    for Report view.

2. Select Transfer from the File Menu, or click   .
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You can customize Data Manager to use an application other than Excel
by editing the file DATAMGR.INI (in your Win-Situ folder) to include these
lines:

[Export]
SSPath=<directory and exe name>

PRINTING DATA

To print the Report or Graph as currently displayed, select Print on the
File Menu. Your Windows documentation has complete information on
print options.

SAVING CHANGES

Data Manager shows when a file has been changed by displaying the
word “Modified” at the lower right corner of the screen. When you close
a file that has been modified, you have a choice of saving the changes
or restoring the binary file to its original state.

EXITING DATA MANAGER

1. Select Exit from the File Menu.

2. If any open files have changed, Data Manager will ask whether you
want to save changes.

• If you click Yes, changes will be made to the original binary file.

• If you click No, the changes will be lost.

• If you’d like to preserve the changes, but without overwriting the
original binary data file, select No, then save the changes in a
text file. See “Saving Text Files” on page 36.
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LIQUID DENSITY

The conversion from PSI units to meters of H2O, or feet of H2O,
requires several conversion factors. One of these is the density (ρ) of
the aqueous solution being monitored. Pure groundwater at 20°C has a
density of 0.998 grams per cubic centimeter (g/cm3).

Use the values in the table below for density if you do not otherwise
know it. However, since these data assume pure water, there is no ac-
commodation for other variables (such as salinity) which can affect your
actual water conditions. (Alternatively, you could compute it; see the
following procedure.)

APPENDIX

Temp. Density Temp. Density Temp. Density
(°C) (g/cm3) (°C) (g/cm3) (°C) (g/cm3)

1 0.999900 11 0.999605 21 0.997992
2 0.999941 12 0.999498 22 0.997770
3 0.999965 13 0.999377 23 0.997538
4 0.999973 14 0.999244 24 0.997296
5 0.999965 15 0.999099 25 0.997044
6 0.999941 16 0.998943 26 0.996783
7 0.999902 17 0.998774 27 0.996512
8 0.999849 18 0.998595 28 0.996232
9 0.999781 19 0.998405 29 0.995944

10 0.999700 20 0.998203 30 0.995646
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DETERMINING DENSITY

The density of water in a well can be determined using an accurate tape
measure and a pressure transducer. A change in pressure is recorded
between two points as the transducer is lowered into the water and the
corresponding change in depth is recorded using the measuring tape.
Density is then calculated using a simple formula. This method is valid
if the pressure and depth measurements are accurate and the water
within the well is homogeneous throughout the entire depth of the well.

Note: Density can also be measured using a hydrometer if it is possible
to withdraw a water sample from the well. We recommend an accuracy
of ±0.0005

Procedure

There are two possible methods for measuring the change in water
depth. Choose the method that is the most convenient and accurate.

• Attach the tape measure to the transducer cable using an adhesive
(e.g., duct tape). The tape measure can be attached to the
transducer itself or to a segment of the cable that will be adjacent to
the top of the well casing. Read the cable positions directly from the
measuring tape. The measuring device must have a resolution of at
least 1 mm or 1/16 in.

• Alternatively, mark the positions of the cable with a felt tip pen. The
distance between marks is then determined with a tape measure
after the corresponding cable segment is removed from the well.

1. Lower the transducer into the well until it is submerged under about
one meter of water.

2. Secure the transducer at a fixed depth using the cable at the top of
the well casing. Wait an hour or so for the system to equilibrate.

3. Take an electronic pressure reading, manually, from the transducer
and record this measurement in PSI.  This is measurement P

1.

4. Read the tape measure relative to some fixed reference point (e.g.,
top of well casing) or mark the position on the cable with a felt tip
pen.  This is measurement L1.

5. Lower the transducer at least three meters deeper into the water
and repeat steps 3 and 4.  These are measurements P2 and L2.

6. Density (ρ) in g/cm3 is calculated using the following:

g   x   (L2 - L1)

(P2 – P1)   x   6.894757
ρ   =

APPENDIX
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APPENDIX

where g is the gravitational acceleration for the location of the well in m/
s2.  P must be in PSI units and L must be in meters.

LOG TEST SCHEDULE

Logarithmic (or simply “log”) sampling optimizes data collection speed
and memory usage for pump and slug tests. The measurements begin
closely spaced and the interval between measurements continuously
increases. The device takes 40 log-normally distributed measurements
per log decade of time. For example, from 10 to 100 minutes,
measurements occur at approximately the following times:

1. 10.0 min. 21. 31.6 min.
2. 10.6 min. 22. 33.5 min.
3. 11.2 min. 23. 35.5 min.
4. 11.9 min. 24. 37.6 min.
5. 12.6 min. 25. 39.8 min.
6. 13.3 min. 26. 42.2 min.
7. 14.1 min. 27. 44.7 min.
8. 15.0 min. 28. 47.3 min.
9. 15.8 min. 29. 50.1 min.

10. 16.8 min. 30. 53.1 min.
11. 17.8 min. 31. 56.2 min.
12. 18.8 min. 32. 59.6 min.
13. 19.9 min. 33. 63.1 min.
14. 21.1 min. 34. 66.8 min.
15. 22.4 min. 35. 70.8 min.
16. 23.7 min. 36. 75.0 min.
17. 25.1 min. 37. 79.4 min.
18. 26.6 min. 38. 84.1 min.
19. 28.2 min. 39. 89.1 min.
20. 29.8 min. 40. 94.4 min

The next log decade, from 100 to 1000 minutes, would look very similar,
but decimal points would be shifted to the right by one place. Similarly,
measurement times in any log decade can be deduced by examining
the decade above, then shifting the decimal point right or left the
appropriate number of places. There may be a slight numerical
difference noted between time values from different logarithmic

TIP: If using a tape measure calibrated in feet, 1 ft  =  0.3048
m (exactly).

Note: An error of 0.001 m (1 mm) in the depth measurement
translates into an error of 0.00085 g/cm3 for density.
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decades due to machine floating-point roundoff, but the actual time
value at which any given data point was taken will be reported
accurately in the data file to the fourth decimal place.

The interval between measurements will continually lengthen, but your
specified Measurement Interval serves as a “linearization” value such
that the interval between measurements will never become greater than
this value. For example, with a Measurement Interval of 20 minutes, the
device’s sampling interval lengthens until a 20 minute interval is
reached, then it begins to sample linearly from that time on at 20-
minute intervals.

In a true logarithmic sampling scheme, the interval between points
would be infinitely short at time t=0 (the start of the test), which implies
infinitely rapid sampling. The device cannot sample faster than once
every 300 milliseconds (0.3 seconds). Thus, a linear sampling rate of
one point each 300 milliseconds occurs for the first 6 seconds into the
test, then the logarithmic decline begins.
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